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Abstract

The purpose of this project is to construct a horizontal electric train controlled
by the Arduino. For the cost that is cheaper than the market and users can be self -
reliant in daily life In which the car size is equal to the electric train that is sold in the
general market. The organizers can write an arduino program to control the movement
of the car from the joystick lever. The built weighing 25 kilograms is powered by a 12
volt battery that provides power to the circuit to control the direction of the car. The
car can support a maximum weight of 100 kilograms and can be adjusted to more than
160 degrees.

Experimental results Found that the operation of the electric train is adjustable,
controlled by Arduino Able to work according to objectives. This Arduino - style electric
train can adjust the sitting position to your desired position. The control to change
direction can be forced forward, backward, left, rigsht turn from the lever from the
joystick as needed. As for the road characteristics, it can be used as smooth and sloping

roads.

(Total 77 pages)
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2.3 XY Joystick Module

Al 2.3 XY Joystick Module

fian : https://www.arduino4.com/product/156/xy-joystick-module
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fian : https://www.amazon.ca/6500rpm-Magnetic-Tubular-Torque-Brushed
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File Edit Sketch Tools Help

Replacexy §

#include <Joy=stick.h>

#include <AxisJoystick.h>
#include <XYReplacerJoystick.h>
#define SW_PIN §

#define VRX_PIN B1

$#define VRY _PIN A2

F T Y PV SR

AW 2.10 Header TUsunsy

2. setup Tudruiiluileiduisdundeaivualndluyneg Wewnsy audinlunisdeu
mds Tag Wluszninnadulnm § alddudiinuasenvnvesilsddu Tneflanduiayld

'
o o

AUSUUTFIAS Tua LRI IAlUSWASUYIN UL RE9SaULREIN LS UANYIN Ul US LAY

q
I

ASILTAVINTU Felaun AmFuAeIiunIs Setup AINSYINIUAE LU NSIAUANTINTANIT I
1UY8 PinMode wazn1s fmuaal Baudrate dwsuldnunesndeaseynsy Wusu wihd
Yoeilsidu setup() Tu Arduino @i Tdviuthdudiuvedusunsugesdniuldussgads
#1399 AlddwmTuMruANISMuYeIsEUY 13 Murusnuaudansiauliiugunsaineeg
P S 7] = % v ¢ o =~ a4 X o = a A

Fa Ardanamuanussalinglaflaiduves Setup() U azgnisenfusvinuiiessouliglfie

mousHAuNTSYIuYedlusunsu TneAdanienussalily daddudiu dwnmi 2.11

File Edit Sketc_h_To_oIE_H_eI_p__ N Wwm=J N vAaiBlIb{

ReplaceXy §

11 void setup() {
12 Serial .begin (8600} ;

14 original = new AxisJoystick (S5W_PIN, VRX PIN, VRY_ PIN):
15 xyReplacer = new XYReplacerdJoystick(original) ;
16}

Amd 2.11 Setup TUsunsy

3. loop Wudiuilaidudsdundesiinualadluyng Wswnsu wu wedduiuilsddu

(%
a

setup() Tneileridu loop() u%‘Lﬁz’j’Uisﬁ;ﬁﬁﬁaﬁé’aam{[,ﬁiﬂsl,msuﬁwmLﬁu’saiawg']6‘] Aululyl
$9u Fad Wisuifisufuguuuures (ANSI - C) dauilffe fleridu main) thuies wiilves
flafidu loop() Tu Arduino Aeldvhmihliuduvedusunsumdn dmiuldussaddaniunm
nsmYinauAne 1es 18 Tusunsy Asesnslilusunsuinnu Taesdafiussgliludtediduilay

gnSENTuLYINUgN Ay suadukaReuluidmuall
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File Edit Sketch Tools Help

Replacexy §

18 |void loop() £

19 Serial.print ("original: " + moveTitle (original->multipleRead(}));
2 Serial.println("™ | replace XY¥: " + moveTitle (XyReplacer-rmultipleRead()))
2 delav (500)»

2}

ha

A 2.12 Loop TWsunsu
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2. pauiummes (commutator)

3. U39

4. wwan

5. Walwan

6. 1A lNiNITULERSS DC
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To Battery

AW 2.13 dudsznauvresuswnas bl

fian : http://www.rmutphysics.com/charud/howstuffwork/motor/motorthail.htm

fan gl 2.13 sawasiihldussvsawimanyiliiinnisvyu sssugfvesudindn 61
Tuimanmiieuiuazndniu uwidtiaaiuaszgaiu amdreuud sz Duuviswivén 2
wii Toewvisluduudimaninia 1Sen31 9715011993 (Armature) YausAwuman suusndu
wiwdnansguiiienii (sevsiluwiwanlihalddmsurewmesyunalg uwidndu vewes

< o v = A o o & ¢ v oA Y]
uadn Inagldudndnansiieuszndandinu) o1sunvesazrnyululaliosainniswen
YoIunan wazfosinisndutivesuimanvuzinyuliaseseu v liAausmdnedis
falilee d1un 19lun1sndudivelvdnae Asuimnes (Commutator) kazuwlse (Brush)
A1sVuTRINaLnesazdant lavazAnwndman Wi ndenay wsizwamdnindndy
dy I =3 < Y 1 @ % ¥ 1y
Nusuved vawmashilii agrglsinufanuisaastwdanininlaieenignisnunaingeu
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nzydn 100 soU wazdoaslnvaammniuwumnes Wallalvlnilvar uunain vy
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suilasulunimaniint wile uaglatu

AN 2.13 vugndalnaindeie deladnszualndinlva Tikviunsynsinanasening
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2.22 Arduino IDE
Arduino IDE Aalusknsudinsuladeuluswnsy, aeulngd wazdUlnanlusunsuad
vadn Arduino vieuesasdug findrefu 1wy NodeMCU %38 WeMos D1 18udu
38n1519e1u Arduino IDE

[
(Y

JUABUN 1 WAlUsWNU Arduino IDE JUu F9ANT 2.14

&8 sketch_marD2a | Arduino 1.2.7
File Edit Sketch Tools Help

sketch_marldZa

I’Jc:i.cl setuap () {
J 4 put wour setup code here, To run Once:

¥

wvoid loop () {
4 put your main code here, to run repeatedly:

Al 2.14 Walusunsy Arduino IDE

fian ; https://poundxi.com

Pupaui 2 a319 Sketch Tyl Tngp@ndiiy File > New #an1wil 2.15

EE shortch_maellas | Arduires 1257
File Edit Sketch Tools

Hi=lp
[4=". 0 Ciril= 0
Opery Rscent =

Sketchbook >

Eh-lmp-lﬂ N e = B ENET L o+
Close =W

Save Cirl= 5

Save An. Cirl=Ehaln -5

Fage Sebup Cirlle Skl + P
Prant Ctri=P

Freferences  Cirls Cormrms

et Tl

AR 2.15 a¥19 Sketch vl

fian https://poundxi.com


https://poundxi.com/arduino-%e0%b8%84%e0%b8%b7%e0%b8%ad%e0%b8%ad%e0%b8%b0%e0%b9%84%e0%b8%a3
https://poundxi.com/nodemcu-%e0%b8%84%e0%b8%b7%e0%b8%ad%e0%b8%ad%e0%b8%b0%e0%b9%84%e0%b8%a3
https://poundxi.com/
https://poundxi.com/
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Jupou 3 Weoulusunsuaslunssiuidunag a1 @sulusunsudmsu Arduino 2

Usgnaulumeflsntu void setup wagilendu void loop fIn i 2.16

e sketch_juloic | Arduino 1.8.5
File Edit Sketch Te¢ Help

sketch_julolc &

void setup() {
pinMode (LED BUILTIM, OQOUTFUT):

void Loop() {
digitalwrite (LED BUILTIMN, HIGH):
delay (100G} ;
digitalwWrite (LED BUILTIMN. LIOW);
delay (1000) ;

T

AN 2.16 Weuluswnsy

fian https://poundxi.com

[% '
U I

Tumeudl 4 Waidsulusunsuasaudaliduiiniulilaeadniiuy File > Save 9Nt

ANTAN9TULN LS EBN N VUNN N wassade Sketch FaA WA 2.17

e sketch_juloic|Arduino 1.8.5

# savesketch Folder as...

Mame: [Blink\

sSaveinfolder: | ¢ || I poundxi i Ardulnn: Create Folder

Places m  Name - | Size Modified
Q, search libraries

@ Recently Used

poundxi

@ Desktop

E3 File system

1320 GBVolume

El38GBVolume

B firefox-addons
i1 Documents

Funs

S cancel | | ESBVED

2NN 2.17 MsUunniuswnsy

fian ; https://poundxi.com


https://poundxi.com/
https://poundxi.com/

25

Jupeuil 5 adnUudUlvan vseazadniiiy Sketch > Upload fanmi 2.18

# Blink| Arduino 1.8.5
File Fdir : ch ﬂE‘Lp

Upload

void setup () {
pinMode (LED_BUILTIN, OUTPUT);

void loop() H
digitalWrite (LED BUILTIM, HIGH):
y (1000 ;

digitalWrite (LED BUILTIM, LOW):
delay (1000Q);
}

And 2.18 MsoulvanlUsunsuasuasa

fian : https://poundxi.com

Tupaui 6 MnBeulusunsugnaed waglidladUamseninamsdulven ailveniy

X . Ay & v a ) a
U1 Done uploadlng LLa%ﬂgﬂJsUaﬂ'n@JiqEJ\T]ULUUSU@V’TNQJE’{SUT]6] NN 2.19

e Blink | Arduino 1.8.5
File Edit Sketch Tools Help

o setup() {
pinMode (LED _BUILTIN, OUTPUT):

void loop() {
italWrite (LED_BUILTIN, HIGH):

ay :
italWrite (LED_BUTLTIN,
delay (1000} ;

s. Maximum is

29 2.19 mysUlnanuasaasadu

fian https://poundxi.com
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il 3.1 AnwdeyavesmadeulusunsuuargUnsaifldlulasamstudaideya
fifnuanuainasy uagvhmseeniuunsiauisuelasusseenidu 2 daw ldun du
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Joystick
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A 4
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YuBiuud uazauuaneng

$wauess | dwtin@landy) uazszeziaan(Guai) Tunsnagauludnwarituings
55 59 70 76 83 55 59 70 76 83

1 6.54 | 6.68 | 6.59 | 6.63 | 6.61 | 6.38 | 6.40 | 6.58 | 6.52 | 6.61
2 6.38 | 6.47 | 6.61 | 6.67 | 6.69 | 6.35 | 6.66 | 6.52 | 6.67 | 6.59
3 6.47 | 6.52 | 6.56 | 659 | 6.76 | 6.43 | 6.49 | 6.64 | 6.73 | 6.68
4 6.51 | 6.58 | 6.67 | 6.64 | 6.74 | 6.38 | 6.45 | 6.61 | 6.65 | 6.74
5 6.56 | 6.52 | 6.69 | 6.61 | 6.79 | 6.35 | 6.63 | 6.56 | 6.69 | 6.72
6 6.53 | 6.55 | 6.64 | 6.73 | 6.75 | 6.33 | 6.56 | 6.59 | 6.74 | 6.75
7 6.57 | 6.49 | 6.67 | 6.71 | 6.81 | 6.41 | 6.51 | 6.67 | 6.67 | 6.71
8 6.49 | 6.54 | 6.71 | 6.65 | 6.67 | 648 | 6.57 | 6.73 | 6.71 | 6.74
9 6.61 | 6.58 | 6.57 | 6.68 | 6.77 | 6.43 | 6.59 | 6.68 | 6.61 | 6.78
10 6.59 | 6.63 | 6.64 | 6.61 | 6.79 | 6.49 | 6.49 | 6.63 | 6.65 | 6.67
11 6.54 | 6.56 | 6.68 | 6.69 | 6.74 | 6.39 | 6.63 | 6.64 | 6.71 | 6.64
12 6.43 | 6.64 | 6.61 | 6.65 | 6.78 | 6.44 | 6.55 | 6.67 | 6.63 | 6.61
13 6.47 | 6.59 | 6.65 | 6.73 | 6.74 | 6.38 | 6.52 | 6.63 | 6.68 | 6.72
14 6.52 | 6.63 | 6.61 | 6.62 | 6.71 | 6.31 | 6.57 | 6.61 | 6.61 | 6.76
15 6.57 | 6.67 | 6.68 | 6.67 | 6.75 | 655 | 6.47 | 6.67 | 6.63 | 6.68
16 6.41 | 6.59 | 6.64 | 6.64 | 6.7/18 | 6.49 | 6.61 | 6.71 | 6.68 | 6.75
17 6.55 | 6.66 | 6.65 | 6.69 | 681 | 6.44 | 6.43 | 6.69 | 6.65 | 6.71
18 6.58 | 6.63 | 6.59 | 6.71 | 6.72 | 657 | 6.54 | 6.65 | 6.71 | 6.74
19 6.53 | 6.64 | 6.68 | 6.67 | 6.77 | 6.45 | 6.57 | 6.68 | 6.67 | 6.69
20 6.67 | 6.69 | 6.64 | 6.69 | 6.79 | 652 | 653 | 6.64 | 6.72 | 6.72
Laﬁa 6.54 | 6.59 | 6.63 | 6.66 | 6.75 | 6.43 | 6.54 | 6.64 | 6.67 | 6.70
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55 59 70 76 83
1 5.48 5.59 5.49 5.55 5.61
2 5.48 5.61 5.52 5.63 5.65
3 5.44 551 5.58 5.58 572
4 5.39 5.47 5.55 5.62 5.68
5 5.45 553 5.53 5.66 5.73
6 5.47 5.62 5.59 5.62 5.78
7 5.45 553 5.57 5.67 5.74
8 5.42 ShoYk 551 5.59 571
9 5.47 Lo 5.59 5.58 577
10 5.43 5.56 5.49 5.64 5.75
11 5.49 5.61 5.47 5.68 5.78
12 5.37 5.49 5.55 5.63 5.74
13 5.45 5.53 5.53 5.67 5.79
14 5.41 5.55 5.52 5.65 573
15 5.48 5.59 557 5.67 577
16 5.46 5.62 NS 5.61 5.74
17 5.42 5.64 5.54 5.65 5.78
18 5.45 5.58 5.55 5.69 5.73
19 5.47 551 5.59 5.65 5.75
20 5.45 566 5.57 5.63 5.82
\de 5.41 5.56 5.54 5.64 5.74
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¥a39lAn XY Joy Stick Module

#include <Joystick.h>
#include <AxisJoystick.h>
#define VRX_PIN AO
#define VRY PIN Al
#define SW_PIN A2
Joystick® joystick;
void setup() {
Serial.begin(9600);
joystick = new AxisJoystick(SW_PIN, VRX_PIN, VRY_PIN);
}
void loop() {
Serial.print("Joystick, Multiple Reading: "),
Serial.printin(fmoveTitle(joystick->multipleRead()));
delay(500); // optionally, only to delay the output of information in the
example
}
String moveTitle(const Joystick::Move move) {
switch (move) {
case Joystick::Move:NOT:
return "NOT";
case Joystick::Move::PRESS:
return "PRESS";
case Joystick::Move::UP:
return "UP";
case Joystick:Move::DOWN:
return "DOWN";
case Joystick::Move::RIGHT:
return "RIGHT";
case Joystick::Move::LEFT:



}

}

return "LEFT";

default:

return "777";
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#define RPWM 3
#define R EN 4
#define R IS5
#define LPWM 6
#define L EN 7
#define L IS 8
#define CW 1
#define CCW 0
#define debug 1
#include <RobojaxBTS7960.h>
RobojaxBTS7960 motor(R_EN,RPWM,R IS, L EN,LPWM,L IS,debug);
void setup() {
Serial.begin(9600);
motor.begin();
}
void loop() {
motor.rotate(100,CW);
delay(5000);
motor.stop();
delay(3000);
motor.rotate(100,CCW);
delay(5000);
motor.stop();
delay(3000);
for(int i=0; i<=100; i++){
motor.rotate(i, CCW);
delay(50);
}
for(int i=100; i>0; i--){

50



motor.rotate(i,CCW);
delay(50);

}

motor.stop();

delay(3000);
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#include <Joystick.h>
#include <AxisJoystick.h>
#define VRX_PIN A0
#define VRY PIN Al
#define SW_PIN A2
Joystick® joystick;
#define RPWM1 3
#define R_EN1 4
#define R IS1 5
#define LPWM1 6
#idefine L EN1 7
#define L IS1 8
#define CW1 1
#define CCW1 0
#define debugl 1
#define RPWM2 9
#define R_EN2 10
#define R 152 11
#define LPWM2 12
#define L EN2 13
#define L 1S2 2
#define CW2 1
#define CCW2 0
#define debug2 1
#include <RobojaxBTS7960.h>
RobojaxBTS7960 motorl(R EN1,RPWM1,R IS1, L EN1,LPWM1,L IS1,debugl);
RobojaxBTS7960 motor2(R_EN2,RPWM2,R IS2, L EN2,LPWM2,L 1S2,debug2);
void setup() {
Serial.begin(9600);// setup Serial Monitor to display information



joystick = new AxisJoystick(SW_PIN, VRX_PIN, VRY PIN);
motor1.begin();
motor2.begin();
}
void loop() {
Serial.print("Joystick, Multiple Reading: ");
Serial.printin(moveTitle(joystick->multipleRead()));
delay(500);
}
String moveTitle(const Joystick::Move move) {
switch (move) {
case Joystick:Move:NOT:
motor1.stop();
motor2.stop();
return "NOT";
case Joystick:Move::LEFT:
motorl.rotate(100,CW2);
motor2.stop();
return "LEFT";
case Joystick::Move::RIGHT:
motorl.stop();
motor2.rotate(100,CW1);
return "RIGHT";
case Joystick:Move::UP:
motorl.rotate(100,CW1);
motor2.rotate(100,CW2);
return "UP";
case Joystick:Move::DOWN:
motorl.rotate(100,CCW1);
motor2.rotate(100,CCW2);
return "DOWN";
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Arduino Nano /0

Usezr Manual
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Released under the Creative Commons Attribution Share-Alike 2.5 License

http://creativecommons org/licenses/by-sa/2 5/

More information:

www.arduino.cc Rev 3.0
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Arduino Nano Pin Layout

o dooni O
p1mx (1) [B%4|0 O Of 30| (30)vIN
DORX  (2) |OF® MOuINe 2O/ (29) GND
RESET (3)|0% _ u@ &f 20| (28) RESET
GND (4) O3> = o8 L20)|(27) +5V
D2 (5) |© —= = =~:O (26) AT
D3 (6) [QE=5= st 20| (25) A6
D4 (7) |O= § HON 20|(24) A5
D5 (8) I02&% o 10| (23) A4
D6 j;ag Qg%% 20 Ezzi A3
D7 (10) |03 “%w0|(21) A2
DB (11) ogﬁ% @-zo (20) A1
D9(12) |08 & =0[(19)A0
D10 (13) |QF ysh 2883 50| (18) AREF
p11(14) |ozm Il m2o|(17)3v3
D12(15) |o2 @ (o 2Q|(16)D13
SN | | B
1-2, 516 Do-D13 1o Digital inputfoutput port 0 o 13
3,28 RESET Input Reset (active low)
4 24 GND PWR Supply ground
17 V3 Qutput +3.3V output (from FTDI)
18 AREF Input ADC reference
19-26 AD-AT Input Analog input channel 0to 7
27 +hY COutput or | +5Y output {from on-board regulator) or
Input +5V (input from external power supply)
30 VIN PWR Supply voltage

Ad ¥ 2 98yav) Arduino Nano
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Arduino Nano Mechanical Drawing
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ﬂ D nRF24L01+ Product Specification
> SEMICONDUCTOR

1.1 Features

Features of the nRF24L01+ include:

+ Radio
» Worldwide 2. 4GHz ISM band operation
» 126 RF channels
» Common RX and TX interface
» GFSK modulation
» 250kbps, 1 and 2Mbps air data rate
» 1MHz non-overlapping channel spacing at 1Mbps
» 2MHz non-overlapping channel spacing at 2Mbps
«  Transmitter
» Programmable output power: 0, -6, -12 or -18dBm
» 11.3mA at 0dBm output power
« Receiver
» Fast AGC for improved dynamic range
» Integrated channel filters
» 13.5mA at 2Mbps
» -B2dBm sensitivity at 2Mbps
» -B5dBm sensitivity at 1Mbps
» -94dBm sensitivity at 250kbps
* RF Synthesizer
» Fully integrated synthesizer
» No external loop filer, VCO varactor diode or resonator
» Accepts low cost +60ppm 16MHz crystal
* Enhanced ShockBurst™
» 110 32 bytes dynamic payload length
» Automatic packet handling
» Auto packet transaction handling
» 6 data pipe MultiCeiver™ for 1:6 star networks
*  Power Management
» Integrated voltage regulator
1.9 to 3.6V supply range
Idle modes with fast start-up times for advanced power management
26pA Standby-1 mode, 900nA power down mode
» Max 1.5ms start-up from power down mode
» Max 130us start-up from standby-l mode
* Host Interface
» 4-pin hardware SPI
» Max 10Mbps
» 3 separate 32 bytes TX and RX FIFOs
» 5V tolerant inputs
« Compact 20-pin 4x4mm QFN package

¥ ¥ ¥
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nRF24L01+ Product Specification N OR I
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1.2 Block diagram

RF Transmitter Baseband
- " Lt % CSN
™ GESK w TXFIFOs
01 Civer [ Moduiator |‘_’ -4 SCK
= SFI
[ —a MISO
- Enhanced ShockBurst MOSI
RF Receiver ) Basaband Engine s I
ANTA H- g 8§ IRQ
RX GFSK
o Filter Demodulator - E " CE
ANTZ H
v ’|—I_‘ RX FIFOs |<—>H ‘E
XC1 —| 4
RF Synthesiser Power Managemant | | Radia Contral 4 -
a [I11] :
O <
38 Lag
= > 22
[=]
=
2 Pin Information
2.1 Pin assignment
[~}
2 8 g g #§
= =] - = H
ORCRUBUSD
=@ (e] weo
CEN 3 E V88
E) nRF24L01+ C
SCK 13 ANT2
QFN20 4X4
wosz [2) (@]
MISD B G V'DD_PA

[} ) (e} (o) (o)
Ao(af

vas
Xxc2
Xxcl

Figure 2. nRF24L01+ pin assignment (top view) for the QFN20 4x4 package
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nRF24L01+ Product Specification

| I SEMICONDUCTO

R

22

Pin functions
Pin Name Pin function Description

1 CE Digital Input [ Chip Enable Activates RX or TX mode

2 CSN Digital Input | SPI Chip Select

3 5CK Digital Input [ SPI Clock

4 MOSI Digital Input | SPI Slave Data Input

5 MISO Digital Output | SPI Slave Data Output, with tri-state option

6 IRQ Digital Output | Maskable interrupt pin. Active low

7 VDD Power Power Supply (+1.9V - +3.6Y DC)

[] Vss Power Ground (0V)

9 xe2 Analog Output | Crystal Pin 2

10 XCl Analog Input | Crystal Pin 1

11 VDD PA Power Output | Power Supply Output (+1.8V) for the internal
nRF24L01+ Power Amplifier. Must be connected
to ANT1 and ANT2 as shown in Figure 32.

12 ANT1 RF Antenna interface 1

13 ANT2 RF Antenna interface 2

14 vss Power Ground (OV)

15 VDD Power Power Supply (+1.9V - +3.6Y DC)

16 IREF Analog Input [ Reference current. Connect a 22k(} resistor to
ground. See Figure 32.

17 vss Power Ground (0V)

18 VDD Power Power Supply (+1.9V - +3.6Y DC)

19 DVDD Power Output |Internal digital supply output for de-coupling pur-
poses. See Figure 32.

20 Vss Power Ground (0V)

Table 1. nRF24L01+ pin function

AN Y 6 ToLAUAREYIYBI Arduino Nano



Ultra-compact power module HLK-PMO1

DETAILS

1. Product festures:

1. Mieet UL, CE reguirements,

2. Utra-thin, ulkra-smsll

2. A ol input AC: 50~ 264v]

3. Lovw rippie ard low reise

4. Dutput overload and short Drowit protection
3. High efficiency, high power density

6. The product is desigred to meet the reguirements of EMC Bnd Safeky Test
7. Low pOoweErT COnsumption, snmvirenmental protection, no-load loss <0.1W

B. 100%: load aging and testing
. 1 year warranty perio

2. Environment Condition
Mame |Technical Critsria unit
Temperabure [-20—+60 PC
Temperature "a0—+a0 o
nuETigEY [
way Iy raciation
Atmosphedic pressura 106 wpa
|Gea level elevation <2000 m
Npration coemciant
Wbeation 0-500Hz, 2G 1 0min./icyse, S0min.each
Fmg XY, Z axes
3.Elecirical Characteristic

1.input characieriatics (teat at reom temperatura 20 <C).

Mama [Tschnical Critsria Frﬂ
Ehpﬂ:m 100-240 Iwc
nput vofage range |30-284
Miadmum Input cument =02 K
nipust cuITent suge =0 &
madmum input voliage =270 rm:
[Enter siow starl =50 m=
nput Low Voltage EMclency Vin=1100Az, Cutput full-loadesg o

WA ¥ 7 YeyagUsensal



nput High Valtage EMclency WIn=220VAC, cutput full-oad=70 =
Lang-tesm reflaniiky MTEF=100, 000 h
Load rated output voitage 45201 e
Full rated cutput voitage 45202 Vo
Ehoat-term maximum cutput cument = 1000 Ima
I E iﬁiuﬂ mf curmend for a
Jong time 500
Vokage Regustan R
Load Regulation .5
Dutput fpple and noiss S0

v Rated Input voitage, full lcad. Lising Z0MHZ of bandwidth, v
[VP-P) The load sklie 10UF and 0.1UF capacitor o be tested.
Ewitch overshaot ampifude Rated Input voltage and output ioad pius 10% S5 me
DUiput ower-cument proiecoon 150-200% of the DULpUt maxkmum load )

CHrect short cincull ﬂﬂEﬂDﬂTﬂ|ﬂm amnamaryremme narmal npaaﬂm aftera

Dutput short elreult protection rm =
4 Safety Characteristics

4.1 Products designed to mest UL, CE safety certfication requirements.

4.2 Safety and slectnomagnetic compatiblity

Designed with the Input of 0.54 UL cerifed Insurance:

PCE boand wsing double-skded copper clad plate produciion, material farthe 94-VD fire rating level;
Salety standards: Compliance with UL1012, EN50350, ULEI250

Insulation voitage: | P-O | P2 2500WAC

Insulation resistancs ;1.7 PO F P> 100M Cmes / S00VIAG 25 %C 70% RH

Conguction and radiafion :comply with ENSS011, ENSS022 (CISPR2Z)

Elesctrostatic discharge JIEC f EM 61000-2-2 level 4 3KV F 15KV

RF radiation Immunity: IEC / EN £1000-4-3 Sse Application Mote

4.3 Temperaturs safety design

A rocm temperature.the capacitons of this power, the Inner surface of the maln converter madmum temperature does not
exceed 90

Shell maximum surface temperature does not excead 5050

5.Loge. packaging. traneportation, storage

5.1 Logo

S.1.1 Product logo

In place of prodwcis |abeled with slgne, Rs conbent in Ine with natkonal standarnds, Industry standards.

£.1.2 Packaging loga

Producis markad with the manufachurers name, address, zip code, product type, manutactured year, month, day on the box ;
Marked “up”, "molsture” “Handle with care™ and other transpariation signs, all skigns a2 In Ing wih he proviskns of GB 191.
£.2 Packaging

Producis are saparated using special plastic box packaging, with anti-vibration funcion, and In accordance with the provisions

Al ¥ 8 TayagUsensal
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of GB 3373.
5.3 Transport

packaged products can be shipped by any transportation service, there shoud be awnings In transport and no excessive
vibration, Impact, etc.

5.4 Storage
Products should be stored In compliance with GBS 3873

6. Wslght and Dimensions :
Weight <20ge ¢
Pin Function«
1e ACe |0
2¢ ACe
29,4 3« =V
é 40- +V0¢- |+
J <
vl | ™
M-Link ™'" —
[ (Y Bgpemediin v v.cined | —— Iy
| NPUT : 100~240VA0 =y
2lem0 m e "
P/N - MLK-PRO1 Woe 4  weees
o] |
L
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' Handson Technology

User Guide

BTS7960 High Current 43A H-Bridge Motor Driver

The BTS7960 is a fully integrated high current H bridge module for motor drive applications. Interfacing to
a microcontroller is made easy by the integrated driver IC which features logic level inputs, diagnosis with
current sense, slew rate adjustment, dead time generation and protection against overtemperature,
overvoltage, undervoltage, overcurrent and short circuit. The BTS7960 provides a cost optimized solution
for protected high current PWM motor drives with very low board space consumption.

SKU: DRV-1012

Brief Data:
e Input Voltage: 6 ~27Vdc.
e Driver: Dual BTS7960 H Bridge Configuration.
e Peak current: 43-Amp.
e PWM capability of up to 25 kHz.
e Control Input Level: 3.3~5V.
e Control Mode: PWM or level
e  Working Duty Cycle: 0 ~100%.
e Over-voltage Lock Out.
e Under-voltage Shut Down.
e Board Size (LxWxH): 50mm x 50mm x 43mm.
e  Weight: ~66g.

AWl ¥ 1048ya BTS7960
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Mechanical Dimension:

43mm

AR ¥ 11 8182995 BTS7960



Schematic Diagram:

Microcontroller Voltage Regulator Reverse Polarity
Protection

SPD
50P03L

High Current H-Bridge

Control Input Pin Function:

| .
m TI111] s 21982008

;ggn(amﬁﬁrﬁ
ax&‘&'k:n.d‘:l_‘

Control Input

Pins
Pin No Function Description
1 RPWM Forward Level or PWM signal, Active High
2 LPWM Reverse Level or PWM signal, Active High
3 R_EN Forward Drive Enable Input, Active High/ Low Disable
4 L_EN Reverse Drive Enable Input, Active High/Low Disable
) R_IS Forward Drive, Side current alarm output
6 L_IS Reverse Drive, Side current alarm output
i Vce +5V Power Supply microcontroller
8 Gnd Ground Power Supply microcontroller

A Wil @ 12 doyausiazanues BTS7960



Motor Power Supply & Output Pin Assignment:

Power Supply Motor Output

Input Pin Pin
Pin No Function Description
1 B+ Positive Motor Power Supply. 6 ~27VDC
2 B- Negative Motor Power Supply. Ground
3 M+ Motor Output +
4 M- Motor Output -

Controlling DC Motor with BTS7960 Using Arduino:

Below is the circuit connection using BTS7960 high power driver to control one DC motor with Arduino

board. The potentiometer allows the control of motor speed and rotation direction of the motor.

AWl ¥ 13 Fesausiaraiwes BTS7960
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Analog Joystick Module

The PS2 style joystick is a thumb operated device, that when put to
creative use, offers a convenient way of getting operator input. It
fundamentally consists of two potentiometers and a push button
switch.

The two potentiometers indicate which direction the potentiometer

is being pushed.

The switch sends a low (or ground) when the knob is pressed.

Pinout

This input device interfaces to your Arduino via five pins. Three of
which are inputs to your Arduino, while the remaining two supply voltage and ground.

GND —To Arduino GND

;4 VCC -~ To Arduino 5V
g 7*.._——- X ~—To Arduino Analog In
\!— To Arduino Analog In

==

-
C)
4
"
=
a
]

KEY —To Arduino Digital In

Arduino PS2 Joystick Schematic

As you can see in the schematic below, full deflection of a potentiometer in either direction will
provide ground or the supply voltage as an output

GND
vcC
X
10K
Y
10K
I KEY

o v 4
AN v 14 T@yja'ﬂ@ﬂﬁmﬂ
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Arduino PS2 Joystick Output Orientation

In order to put this thumb control to use, you are going to want to understand which direction is X
and which direction is Y. You will also need to decipher the direction it is being pushed in either the X
or the Y direction.

In this tutorial we are using analog inputs to measure the joystick position. The analog inputs
provided indications that range between 0 and 1023.

The graphic below shows the X and Y directions and also gives an indication of how the outputs will
respond when the joystick is pushed in various directions.

X=512
Y =1023

X=1023
Y=1023 .

X=1023
¥Y=512

Connection to Arduino

Note that | use a pull up resistor between the key switch and the digital input. Once you move
beyond experimentation, | highly recommend some sort of software or hardware debounce for this
switch as well.

®

Hapsiop

~»  ARDUINO

o
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